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Topics to cover... 
...

• Credit-card sized computers  

• Arduino: overview   Arduino  

• Setting up Arduino    Arduino 

• Software development environment for Arduino  
 Arduino  

• Interfacing with the real world 
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Credit-card sized 
computers

3



© 2015-2016 YIP Chi Lap [Beta]Invention for Schools Contest

Why credit card-sized computers? 
?

• Low cost  

• Small  

• Portable  

• Programmable  

• Can be used as a desktop computer  
 

• Can be connected to other electronic components to make different 
devices 
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Arduino: overview
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Image source: 
• https://www.arduino.cc

Arduino 

https://www.arduino.cc
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What is Arduino? 
 Arduino

• An open-source prototype platform based on easy-to-
use hardware and software.  

 

• Can be connected to other electronics components to 
make different devices. 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Some of the Arduino models 
 Arduino 
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Arduino UNO / Genuino UNO 

Comparison  :  
https://www.arduino.cc/en/Products/Compare 

Arduino Due Arduino Yun

Arduino LeonardoArduino Zero

https://www.arduino.cc/en/Products/Compare
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Sockets for connecting the Arduino to other electronics 

Power connector 

USB connector used 
to load programs on 
to Arduino from 
computer USB  

 Arduino

Sockets for connecting the Arduino to other electronics 

Image source: 
• https://www.arduino.cc
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https://www.arduino.cc
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What can Arduino be used for? 
Arduino 

• Able to read inputs, such as light on sensor, a finger on a 
button, or a Twitter message.  

Twitter  

• Generate an output such as activating a motor, turning 
on an LED, publishing something online.  

LED
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What can Arduino be used for? 
Arduino 
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Arduino 
Arduino LED

Image source: 
• http://playground.arduino.cc/Main/ArduinoComic 

http://playground.arduino.cc/Main/ArduinoComic
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Setting up Arduino 
 Arduino
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Setting up Arduino 
 Arduino

• What you need : 

• Power supply.    

• A male type A USB to male micro USB cable. 
 Type-A USB  micro USB  

• A software development environment for Arduino.  
 Arduino 
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Main reference: 
• Setting up your Raspberry Pi.  Quick Start Guide.  https://www.raspberrypi.org/help/quick-start-guide/

https://www.raspberrypi.org/help/quick-start-guide/
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Power supply 

• Use a 5V micro USB power supply. 
5V micro USB  

• Power bank for mobile phone. 
 

• Computer USB port. 
 USB  

• USB power supply. 
USB  

• A male type A USB to male micro USB cable. 
 Type-A USB  micro USB 
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Image sources: 
• http://hken.rs-online.com/web/p/plug-in-power-supply/8226373/ 
• http://hken.rs-online.com/web/p/power-banks/7757508/ 
• https://www.facebook.com/orico.hk/photos/a.644756615659662.1073742025.147921822009813/644756678992989/

http://hken.rs-online.com/web/p/plug-in-power-supply/8226373/
http://hken.rs-online.com/web/p/power-banks/7757508/
https://www.facebook.com/orico.hk/photos/a.644756615659662.1073742025.147921822009813/644756678992989/
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Software development environment for Arduino 
 Arduino 
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Programming the Arduino 
Arduino 

• Visual programming : Scratch for Arduino 

• Easy to learn.  

• Writing code on the Arduino IDE.  
 Arduino IDE  

• Nearly identical environment for Processing 
programmers. 

 Processing 
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Main references: 
• https://www.raspberrypi.org/documentation/usage/

https://www.raspberrypi.org/documentation/usage/
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Programming the Arduino: Scratch for Arduino 
 Arduino: Scratch for Arduino
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Image source: 
• http://s4a.cat 

http://s4a.cat
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Programming the Arduino: Arduino IDE 
 Arduino: Arduino IDE
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Image source: 
• https://www.arduino.cc

https://www.arduino.cc
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Installing the Arduino IDE 
 Arduino 

• Download from  
https://www.arduino.cc/en/Main/Software 

• Install the software  

• The Arduino Integrated Development  
Environment (IDE) looks like this after 
successful installation. 

 Arduino  
(IDE) 
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References: 
• https://www.arduino.cc/en/Guide/HomePage 
• https://www.arduino.cc/en/Main/Software

https://www.arduino.cc/en/Main/Software
https://www.arduino.cc/en/Guide/HomePage
https://www.arduino.cc/en/Main/Software
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Scratch for Arduino

• A visual programming tool which allows the user to create 
animations and games with a drag-and-drop interface. 

 

• Scratch is an MIT project: 
Scratch https://scratch.mit.edu/ 

• Scratch for Arduino (S4A) is a modified version of Scratch to be 
used with Arduino. 
Scratch for Arduino (S4A)  Scratch  
Arduino  

• Web site http://s4a.cat/

19

https://scratch.mit.edu/
http://s4a.cat/
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Installing Scratch for Arduino

• Install Arduino IDE first.  Arduino  

• Download Scratch for Arduino from here  
http://s4a.cat/#downloads  
Install the software.  

• Download the firmware.  

• Save the file linked by "Download our firmware from here" at http://
s4a.cat/#downloads (direct link at http://vps34736.ovh.net/S4A/
S4AFirmware16.ino) 

 http://s4a.cat/#downloads  "Download our firmware from 
here"  (  http://vps34736.ovh.net/S4A/
S4AFirmware16.ino)

20

http://s4a.cat/#downloads
http://s4a.cat/#downloads
http://vps34736.ovh.net/S4A/S4AFirmware16.ino
http://s4a.cat/#downloads
http://vps34736.ovh.net/S4A/S4AFirmware16.ino
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Installing Scratch for Arduino

• Make sure Scratch for Arduino is not open.  
 Scratch for Arduino  

• Connect Arduino to the computer using a USB cable. 
 Arduino  USB  

• Open Arduino IDE.  
 Arduino  

• Open the firmware file S4AFirmware16.ino in the IDE.  
 Arduino  S4AFirmware16.ino
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Installing Scratch for Arduino

• In the Tools menu, select the board version and the serial port 
where the board is connected.  

 Tools  Arduino  

• Load the firmware into your board through File > Upload  
 File > Upload  

• Close Arduino IDE.  Arduino  

• Start Scratch for Arduino, it should be able to find your 
Arduino board.  

 Scratch for Arduino  Arduino .
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Installing Scratch for Arduino

• Microsoft Windows users may need to install the Arduino 
drivers, available at http://s4a.cat/#drivers. (Direct link 
http://vps34736.ovh.net/S4A/drivers.zip) 

 Arduino  
http://s4a.cat/#drivers http://
vps34736.ovh.net/S4A/drivers.zip  

• To avoid confusion, do not run Scratch for Arduino and 
Arduino IDE at the same time. 

Scratch for Arduino  Arduino 
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http://s4a.cat/#drivers
http://vps34736.ovh.net/S4A/drivers.zip
http://s4a.cat/#drivers
http://vps34736.ovh.net/S4A/drivers.zip
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Interfacing with the real world 

You need some electronic components...
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Know the components: 
    Light Emitting Diodes (LEDs) 

26
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• An LED is a semiconductor component.  
 

• LED is a special kind of diode, which is a component that allows one-
way flow of current only. 

  

• What makes LED different from a normal diode is that when there is 
current flow, it lights up.  

  

• Usually, a resistor is needed to limit the current flow through an LED so 
it would not be burnt. 

Light Emitting Diode 

27
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• Since an LED allows unidirectional current flow only, it is 
polarized.  

 

• The direction of current flow is along the triangle in the circuit 
diagram. 

 

• The side current enters is marked as positive using the + symbol, 
and the other side negative using the – symbol.  

 +  –  

• The lead on the positive side of a new LED is often longer.  

Light Emitting Diode 

28
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Light Emitting Diode 

• The polarity of an LED can also be determined by looking 
at the transparent or translucent LED itself.  

 

• Inside an LED, one side is larger in size than the other. 
The larger side connects to the negative (–) terminal. 

 

• Which is the positive terminal in this LED?  

29
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• What are the polarities of the LEDs Cony is holding?  

LED quiz!   LED

30



© 2015-2016 YIP Chi Lap [Beta]Invention for Schools Contest

Know the components: Resistors 

31
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Resistors 

• In a circuit diagram, the zig-zag symbol correspond to resistors.   
 

• Resistors limit current flow and its values are measures in ohms, 
with the greek letter Ω (Omega) as symbol. 

Ohm, Ω  

• Resistors are non-polar. That is, unlike batteries, installing a 
resistor one way of another does not matter.  

  

• Resistors look like those in the picture.  

32
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Ohm's law 

• The larger the value the resistor, the smaller will be the current flow given 
the same voltage. 

  

• With a resistor value of R and a voltage of V, the current 
I=V/R. This is called the Ohm's law and can be remembered as V=IR. 

 V,  R,  I  V/R   
V=IR  

• Many components like light emitting diodes (LEDs) cannot bear too much 
current, and resistors are used in series with them to limit the current so 
as not to damage them. 

33
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Colour coding 

• Resistors and some other components are colour coded. 

34
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Colour code table 

• Four color bands are used for 
resistors with ±5% or ±10% 
tolerance. 

 ±5%  ±10% 
 

• Five color bands are used for 
resistors with ±1% tolerance.  

 ±1% 

35

Colour Value Multiplier Tolerance

Black 0 x 100

Brown 1 x 101 ±1%

Red 2 x 102

Orange 3 x 103

Yellow 4 x 104

Green 5 x 105

Blue 6 x 106

Violet 7 x 107

Grey 8 x 108

White 9 x 109

Gold x 10-1 ±5%

Silver x 10-2 ±10%
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To read resistor values 

• First, identify the tolerance band. If there is a gold or silver band at 
the end of the resistor, it must be the tolerance band. Otherwise, 
probably your resistor has five colour bands, and a brown band at 
one end, which could be a bit separated from other bands or very 
much near the end of the resistor, is the tolerance band. 

 
 

 

• The colour band besides the tolerance band is the multiplier band. 
Other colour bands are value bands.  

 
 

36
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Reading resistor colour code 

• From the opposite side of the tolerance band, start reading the value bands. 
This would form a two- or three-digit number. The value of the resistor is the 
number, multiplied by the multiplier indicated by the multiplier band, in ohms. 

 
 

37
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What are their resistance values? 

38

Image source: 
• Yet another picture of resistors. By Omegatron. https://commons.wikimedia.org/wiki/File:Resistors.jpg

4 7 1 5% => 47x101 = 470Ω

3 0 1 0 1% => 301x100 = 301Ω

4701 1% => 470x101 = 4.7kΩ

104 5% => 10x104 = 100kΩ

https://commons.wikimedia.org/wiki/File:Resistors.jpg
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Preferred values 

• Resistor values may have errors, and tolerance values tell their range. 
 

• Preferred values, derived from tolerance values, are used to make mass 
production of resistors easier. 

 

• E-12 series, most commonly used, designed for resistors with 10% tolerance: 
 E-12  10%  

10, 12, 15, 18, 22, 27, 33, 39, 47, 56, 68, 82 

• E-24 series, often available in resistors with 5% and 1% tolerance: 
E-24  5%  1%  
10, 11, 12, 13, 15, 16, 18, 20, 22, 24, 27, 30, 33, 36, 39, 43, 47, 51, 56, 62, 
68, 75, 82, 91

39

References: 
• https://www.youtube.com/watch?v=jSPNvJ0XYCQ 
• http://www.resistorguide.com/resistor-values/

https://www.youtube.com/watch?v=jSPNvJ0XYCQ
http://www.resistorguide.com/resistor-values/
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Resistor quiz!   

• What's the resistance of the resistors Cony is holding?  

40
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Ohm's law: example 

• An LED operates at 1.5V and can take up at most 5mA 
of current.  What should the series resistor value be when 
the power supply is 5V? 

1.5V  5mA 
 5V

41

V+

? Ω
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Ohm's law: example 

• An LED operates at 1.5V and can take up at most 5mA of 
current.  What should the series resistor value be when the 
power supply is 5V? 

1.5V  5mA 
 5V  

• Answer : (5V-1.5V)/5mA = 3.5V/0.005A = 700Ω 

• Higher resistance limits the current more, so a rule of thumb 
is to use a value slightly more than 700Ω,  
e.g., 820Ω. 

700Ω 
 820Ω

42

V+

700Ω
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Connecting to the real world 

43
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Breadboard 

• A breadboard is a board with internal connections and 
holes for placing components. 

 

• Usually, there are connected holes on the two sides for 
power supply connections (black for ground, red for positive 
voltage), and those in the middle are connected every row, 
though rows on the two sides are not connected. 

44
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Breadboard: internal connections 

• The power connections are marked on the surface of this 
board. 

45
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Connecting components 

• Electronic components are connected using wires on a 
breadboard. 

46

Jumper cables Jumper wire roll Flat cable with connectors 
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A S4A program 
 S4A 

• Components have to be connected to the Arduino in a particular way. 
 Arduino  

• S4A allows for:  
S4A  

• 6 analog inputs (analog pins)   , 

• 2 digital inputs (digital pins 2 and 3)    2  3 , 

• 3 analog outputs (digital pins 5, 6 and 9)     5, 6  9 , 

• 3 digital outputs (pins 10, 11 and 13) and    10, 11  13  

• 4 special outputs to connect Parallax continuous rotation servomotors (digital pins 4, 7, 8 
and 12). 

 Parallax  4, 7, 8  12

47

Reference: 
• http://s4a.cat/

http://s4a.cat/


© 2015-2016 YIP Chi Lap [Beta]Invention for Schools Contest

A Scratch program 
 Scratch 

• To switch on or off a digital output on an Arduino board, 
use the digital on or off block. 

 digital on  off  

• To output an analog value,  
use the analog value block.  

 analog value  

48
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A S4A program 
 S4A 

• Which output pin does the program use?  
 

• Digital pin 13.   13. 

• What does it do?  

• Repeatedly turn on digital output 13 
for 0.2 seconds, then turn it off 
for 0.2 seconds. 

 13  0.2  0.2 

49
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S4A Blinking light 
S4A 

• What should the circuit be if the program 
is to control an LED? 

 

• Remember how the circuit to light up an LED looks like? 
 

• It's like this.  

• How to use digital output pin 13 to control 
the LED?  

 13  

• This works. 

50

V+

820Ω

V+

820Ω

digital pin 13
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A new program......  

• Which part is different? 

51



© 2015-2016 YIP Chi Lap [Beta]Invention for Schools Contest

• The loop runs, and thus the LED blinks, only when digital 
input 2 is high. 

 2 

What does this program do? 

52
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• We need to connect digital pin 2 to power through a push button.  A pull down resistor is also 
needed because when the button is not pressed, the input voltage is in high impedance state 
and is prone to noise. 

 2 
 

• Pull down resistor value is typically one to a few kΩ. 

And the circuit is... 

53

V+

820Ω

digital pin 13

digital pin 2

V+

V+

V+

1kΩ
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Programming in Arduino IDE 
Arduino 

• Code inside setup() is run once at start of program. 
setup()  

• Code inside setup() is run periodically, many times a 
second.  
setup()  

54
Reference: 
• https://www.arduino.cc/en/Reference/HomePage

https://www.arduino.cc/en/Reference/HomePage
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A few useful functions 

• pinMode(pin, mode) sets the mode of a pin. 
mode can be INPUT, OUTPUT, or INPUT_PULLUP. 

 

• digitalWrite(pin, value) outputs a HIGH or LOW value to a digital 
pin.  

• digitalRead(pin) reads the value from a specified digital pin, either 
HIGH or LOW.   

• delay(ms) pauses the program for ms milliseconds.  
 ms 
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Reference: 
• https://www.arduino.cc/en/Reference/PinMode 
• https://www.arduino.cc/en/Reference/DigitalWrite 
• https://www.arduino.cc/en/Reference/DigitalRead 
• https://www.arduino.cc/en/Reference/delay

https://www.arduino.cc/en/Reference/PinMode
https://www.arduino.cc/en/Reference/DigitalWrite
https://www.arduino.cc/en/Reference/DigitalRead
https://www.arduino.cc/en/Reference/delay
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The two programs in Arduino IDE 
Arduino 

56
Reference: 
• https://www.arduino.cc/en/Reference/HomePage

https://www.arduino.cc/en/Reference/HomePage
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Tools 

• Multimeter  

• For testing components  

• Cutter pilers  

• For cutting component leads short 

57
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Thank you 

Questions? ?

© 2015-2016 YIP Chi Lap [Beta]


